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1. INSTALLING THE SOFTWARE 
 

1.1 Installing DataView® 
 
 

 
DO NOT CONNECT THE DEVICE BEFORE YOU HAVE INSTALLED THE SOFTWARE AND ITS 

DRIVERS.
 

 

 
Minimum configuration required: 

 Windows XP / Windows Vista & Windows 7 (32/64 bits) 
 256 MB de RAM pour Windows® XP 
 1 Go de RAM pour  Windows Vista & Windows 7 (32 bits) 
 2 GB of RAM for Windows Vista & Windows 7 (64 bits) 
 80 MB of space available on the hard disc (200 MB recommended) 
 CD-R M drive O

 Note: During the installation, the user must have administrator access rights. The 
user's access rights can be modified once installation is terminated 
 Note: DataView® must be reinstalled for each user in a system with more than one 
user. 

 
1. Insert the DataView® CD-ROM in the drive of your PC. 

If autoboot is not deactivated, the right installation program will start automatically. 

If this function is disabled, select "Execute..." in the "Start" menu and type the command 
"D:\SETUP" (the "D" designates the CD drive; use the letter that identifies your own drive). 

 
 Note: For installation under Vista, in the User Account Control window, select the 
"Allow" option 

 
2. An installation choice window opens, identical to the one in figure 1-1 below: 
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Figure 1-1  

 
T

D stalls DataView® on the PC. 

ments supplied with DataView®. 

* DataView Updates - Links to the online DataView® software updates to check for new software 
version releases. 

* Firmware Upgrades - Link to updates of the microprogram to look for new versions of this 
microprogram. 

Documents - Shows a list of instrument related documents that you can view. Adobe® Reader is 
required for viewing PDF documents supplied with DataView®. 

 
3. The DataView, Version x.xx.xxxx option should be selected by default. Select the desired 

language and then click on Install. 
4. The Installation Wizard window will appear. Click Next. 
5. To proceed, accept the terms of the license agreement and click Next. 
6. In the Customer information window, enter a name and a company, then click on Next. 
7. In the "Type of installation" window, choose the "Complete" option, then click on "Next". 

8. In the "Select the functions" window, select the type of instrument you want to use (here, Simple 
Logger II), then click on "Next". 

 
 Note: The "PDF-Xchange" option must be selected for DataView® to be able to 
generate report files in PDF format. 

 

here are several different options to choose from. Some options (*) require an internet connection. 

ataView, Version x.xx.xxxx - In

* Adobe Reader – Link to the Adobe® website to download the most recent version. Adobe® 

Reader is required for viewing PDF docu
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Figure 1-2 
 

9. In the "Ready to start installation" window, click on "Install". 

ion 10. If the chosen instrument requires the use of a USB port (this is the case here), an informat
window like that shown in figure 1-3 opens. 

 

 
 

Figure 1-3 
 

 
The installation of the drivers may take a few moments. Windows may even indicate that it is not 
responding, however it is running. Please wait for it to finish. 

11. When the drivers are finished installing, the Installation Successful dialog box will appear. 
Click on OK. 

12. Next, the Installation Wizard Complete window will appear. Click on Finish. 

13. A Question dialog box appears next. Click Yes to read the procedure for connecting the 
instrument to the USB port on the computer. 

 
The Set-up window remains open. You may now select another option to download (e.g. Adobe® 

Reader), or close the window. 

 

14. Restart your computer, then connect the device to the computer as described in section 4.2. 
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Shortcuts for DataView® and for each type of device are added to the desktop during the installation 
process. 
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2. INSTRUMENT PANEL OF THE SIMPLE LOGGER® II 
 

2.1  Opening the instrument panel 
 
To open the instrument panel of the Simple Logger® II: 
Double click on, the Simple Logger® II icon installed on the desktop. A connection window then opens 
(see figure 2-1) 
 

 Note: When the icon on the desktop is actuated and only one instrument is physically 
connected to the PC, the connection is made automatically. 

 

 
 

Figure 2-1 

he connection window indicates, from the scrolling list, the instrument with which to establish the link. 

era e one you want (identified 
by its se

The ins

The def b-
menu (s
 

 
Tips: C top right of the toolbar to change the sizes and 
position

For add
included

 

Description of the instrument panel 
 

The ins

The ins  or 
by doub

 
T

If sev l instruments of the same type are physically connected, select th
rial number) in the list and click on "OK". 

trument panel of the Simple Logger® II is now open. 

ault layout can be displayed by selecting the "File" menu and the "Import a presentation" su
ee figure 2-2). 

 Note: The default layout can be modified by moving and resizing each window (see § 
2.5 for the backup of the page layouts). 

lick on the window modification icon at the 
s of the windows in a single operation. 

®ition information and instructions concerning the use of DataView , use the help menus 
 in the software. 

2.2  

trument panel is used to configure and control the instrument. 

trument panel can be opened by clicking on the instrument panel option of the main menu
le-clicking the Simple Logger® II icon on the desktop. 
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Figure 2-2 

 
he main menu, at the top of the screen, gives access to the following commands: 

File 

Record the presentation: record the page layout of the current window. 

Open the configuration: restore a previously recorded configuration of the device. 

time in a specified 

 option is selected, the operator is prompted to 
ows showing the evolution of the measurements (those 

being displayed) are then recorded in this file. 

Print: Prints the selected real-time window. 

ion: display of the printer choice and configuration window for selection of 

 

ments. 

dow showing the spectrum of harmonics in real time. 

 
strument 

Connect: establishment of communication with the device. 

Disconnect: closure of communication with the device. 

Configuration: display of the configuration window of the device. 

Download data: download recorded data from the connected device. 

T
 

Import a presentation: restore a previously recorded page layout. 

Start recording the values in real time: storage of all data in real 
database. 

Record the slow variation data: when this
specify a file name. The various wind

Print preview: provides a view of the window as it will be after printing. 

Printer configurat
the print options. 

Exit: closes the instrument panel 

View 
Trend: opening of a graphic window showing the evolution of the measure

Waveform: opening of a graphic waveforms window in real time. 

Harmonic: opening of a bargraph win

Status: opening of a window displaying status information concerning the device. 

In
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Start / Stop recording: if the instrument is stopped, this command starts recording 
immediately, for the specified duration; if the instrument is recording, this command stops it. 

Date and Time of the device: display of the Date/Time window, used to modify the date and 
time of the connected device. 

Erase the memory of the device: erasure of all recorded data. The configuration of the 
device is preserved. 

Clear the alarms: clear any alarm indications on the instrument and in the status window in 
the instrument panel. 

 
Tools 

Colours of the traces: lets the user choose the default colours to attribute to the graphic 
traces according the configuration. 

Colours of the traces according to input: lets the user choose the default colours to 
attribute to the graphic traces according to the type of input. 

Recover the measurements: used to recover the last ".dat" data file downloaded and 
recorded temporarily on the PC in a directly usable database. 

Default forms: this option lets the user choose a DataView® form report other than the one 
proposed as default. 

 
Window 

Cascade: superposition of the windows in the form of a stack, leaving each title bar visible. 

Mosaic: arrangement of the windows without overlap, so that they are all visible. 

Reorganize the windows: arrange the various trend windows in a single window the size of 
the instrument panel window. 

 
 Note: In addition, a list of open windows is displayed at the bottom of the screen. 
Selecting one in the list activates i y useful when a window is masked by one or 
more other windows. 

 

Instrument panel: display of the main help item of the instrument panel. 

How to?: display of the How to? help items 

 

2.3  Description of the various configuration possibilities of a 
Simp ®

 
To open

1. O mple Logger® II and connect the instrument; select it if 
necessa

2. T
sho en opens. 

 
he instrument cannot be modified if the instrument is in 

 
 

t. This is ver

Help 

Contents: display of the table of contents of the help function. 

About: display of the About window. 

le Logger  II 

 the configuration window of a Simple Logger® II, proceed as follows: 

pen the instrument panel of the Si
ry (possibly, refer to § 2.1. for the opening of the instrument panel). 

hen select Configuration in the Device menu. A configuration dialogue window like the one 
wn below (figure 2-3) th

 Note: The configuration of t
record mode. Recording must be stopped before any change is made. 
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.  
 

Figure 2-3 
 

2.3.1 
 
Figure 2-3 show
 

Interva
Select t
 
Duratio
in the lis
 

 
Immediate start: When this box is checked, the starting/ending date/time controls can no 
longer be adjusted and are shaded. 
When the configuration has been sent to the instrument and any conditions are met, recording 
starts for the specified duration. 
 
Update of date / time: updates the various date/ time or duration tabs according to the 
modifications made. 
 
Erase: erasure of all measurement and alarm data in the memory. 

Record tab 

s the first page (Record) and lets you define the following parameters: 

l: time interval between data records in the memory of the logger. 
he desired recording interval from among the values in the list. 

n of recording: Select the desired total duration of recording from among the values 
t. 

Starting date, Starting time: Define the date and time recording starts. 
 
Ending date and Ending time: Define the date and time recording ends (this is another way 
to define the duration of recording). 
 
Programmed recording session: this option must be selected to access the starting/ending 
date/time adjustments. 
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The Memory window indicates the total memory, the memory available, and the memory 
on. Changes made to the duration of recording, the 

channels automatically update the quantity of 

ding mode: management of data recording when the memory is full. Choose one of the 

on of recording may therefore depend on the quantity 

- FIFO: recording starts at the specified time and continues until the recording ending 
time is reached. When the memory is full, the oldest recorded data are successively 

grammed end of recording. For example, if the 
ilable memory allow 8 hours of recording, and a recording 

will be those of the last 8 hours of the 

time is reached. When the memory is full before the recording ending time is reached, 

samples covering the whole of the desired duration, but at a record rate that is halved 
each time the memory is full. 

 
- ALARM: the evolutions (or trends) of the measurements are recorded only if one or 
more channels are in alarm condition. This mode presupposes that the alarms have 
been configured and activated. Recording stops when the ending time is reached or 
the memory is full (see the tab concerning the configuration of the alarms). 
 

Start-up mode: Select one of the following two modes for the start of recording (synchronized 
with the recording rate or not): 
 

- Normal: recording starts at the specified time, whatever the recording rate. 

- Synchronous: recording starts at a time synchronized to the recording interval 
chosen. For example, if the recording interval is 5 seconds, recording starts at 0, 5, 
10, 15, 20, 25, 30, 35, 40, 45, 50, or 55 seconds in a clock minute. If the starting time 
matches a synchronous value, recording starts at the specified time. If not, recording 
starts at the first synchronization after the specified starting time. Starting is delayed 
only when there is a wait for a synchronization. 

Adjusting the Clock: opens a window in which to adjust the date and time of the device. 

Measurement configuration: lists the channels available on the connected logger. When 
several channels are available, you can activate or deactivate recording for each channel. At 
least one channel must be selected for recording to be started. 
 
Measurement input scales: used to select specific scales (or ranges) of inputs (availability 
according to type of input and model). 

required for the current configurati
recording interval, and the number of active 
memory required. 
 

ecorR
three modes below: 
 

- Start/Stop: recording starts at the specified time and continues until the memory is 
full or the recording ending time is reached. Recording stops at the first of these two 
conditions satisfied. The durati
of memory available and on the recording interval. 

replaced by the new data until the pro
record interval and the ava
duration of 24 hours is selected, the data kept 
24-hour recording period. 

- XRM: recording starts at the specified time and continues until the recording ending 

every other sample is discarded (thereby clearing half of the memory). The record rate 
is therefore halved (the interval is doubled) and recording continues, and so on until 
the recording ending time is reached. This mode produces a record containing 



 12

 

Other commands (bottom of the screen): 

n of the instrument and updating of the various relevant 
fields. 

The Configure the device window also contains a memory status zone. This zone displays 

n. 

2.3.2 
 
When th indow opens. 

his second page lets you select an input range or coefficient for each input channel that can be 
parameterized. 
 

input scale: this window is empty when the input ranges have fixed scales. You can specify a 
scale for inputs that are not fixed (ammeter clamps, for example). For example, 1 V = 1,000 A. 
 

 

 
Read: reading of the configuratio

 

Record: records the current configuration in a file. 

the quantity of memory used, the quantity of memory available, and the quantity of memory 
required for the selected configuratio
 

Load: used to select and restore a previously recorded configuration. 
 

Adjustments of the Scales 

e Scales tab is selected, the Scales w

T

 
Figure 2-4 
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2.3.3 djustment of the Alarms 
 
When th

This thi llowing options: 
 

s. 

in the 
channel is equal to one of the specified limits. 

the "Above upper limit" type of alarm and do not select 
"Inclusive ", the alarm is triggered if the measured value is greater than the specified upper 

A

e Alarms tab is selected, the Alarms window opens . 

 page lets you parameterize the ford

Alarms: each channel is configured independently of the others. Only the channels selected 
for recording can be given alarm

The alarms are defined by selecting the desired channel, the type of alarm, then the alarm 
limits. Check the "Include the thresholds" box to trigger the alarm when the level 

For example, when you select 

limit. Select "Inclusive" for the alarm to be triggered when the measured value is greater than 
or equal to the specified upper limit.  

 

 
Figure 2-5 

 

 REMARK: each channel is independent and can have different alarm adjustments. 

 
 
 
The in
 

strument panel includes three other buttons (at bottom right), used to: 
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OK: finalize the configuration; the configuration of the three previous pages is saved, t
necessary information is transmitted to the instrument, the instrument

he 
 panel closes on a new 

confirmation window. 
 
Cancel: cancel the configuration; the instrument panel window closes and the various 
modified parameters are cancelled. The changes made are not applied and the previous 
configuration remains unchanged. 
 
Help: obtain help; without the instrument panel closing, a new window opens to let you obtain 
help or additional information. 

 
If you want to start recording, return to the Record tab and select Record now, then confirm by OK. 
The configuration is then transmitted to the device and recording starts (if memory is available). 

2.3.4 Recording configuration 
 
When instrument contains functional batteries, as soon as the connection is established upon the 
opening of DataView®, the latter automatically switches to Stand-by mode or remains in Record mode. 

 

1.  If the instrument is in record mode, recording must be stopped using the Start/ Stop command of 
the Device menu of the instrument panel (it may then be necessary to save the recorded data in 
order to clear memory space in the instrument; see the corresponding chapter for the 
procedure); 

2.  In the Device menu of the instrument panel, select Configuration; 

3.  In the configuration window opened, the Record page is normally displayed; if not, select the 
Record tab to open it; 

4.  In this page, in the Configuration of the measurement part, select one by one the channels 
available according to the model, then check or uncheck the Record box for each channel; 

5.  According to the model, use the Sca pen the corresponding page to determine 
coefficients and units (this page remains shaded and cannot be modified for models having fixed 

 possibly monitor and record deviations exceeding certain limits, open the Alarms page using 

rmanent alarm and consume far more 
memory than planned; 

7.  R ing mode (Start/Stop, FIFO, XRM™, or 
A

8.  In
tim e values proposed (the list of valid 
values is obtained by clicking on the vertical scrolling arrow; selecting a value, or a 2nd click, 
cl

9.  Sim

10. In
th
re the recording 
duration chosen previously; 

11. Th  in this window) indicates the quantity of memory available and the 
qu tion of the parameters requested. Changing the parameters 
au

12. O ur PC (see § 2.3.5. below). 

13. To start the session, select OK; after a command confirmation window, the configuration 
information is transmitted to the instrument for recording according to the specified parameters. 

14. Recording can also be started immediately by first checking the Immediate Recording box, in 
which case the starting date and time configured become invalid and are shaded. Recording in 
this case starts when the command confirmation window is closed. 

les tab to o

scales and units); 

6.  To
its tab and determine the various thresholds for which an alarm will be reported and recorded 
(the alarms must be activated and configured, or not, for each of the channels to be recorded). 
Warning: incorrectly defined thresholds can result in a pe

eturn to the Record page and select the data record
larm), select the type of recording starting time (normal or synchronous); 

 the same window, a rapid reset of the instrument clock can be performed with the Date and 
e button; then select a recording interval from among th

oses the list); 

ilarly, select a recording duration from among the values proposed; 

dicate, in the corresponding windows, the desired recording starting date and time (a click on 
e Preset the date and time button displays the current date and time plus 60 seconds). The 
cording ending date and time are adjusted automatically as a function of 

e Memory zone (at top right
antity required as a func
tomatically resets the quantity of memory required. 

nce this configuration is terminated, it can be saved in yo
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Figure 2-6 below shows the recording page (programmed) of an instrument of which the four inputs 
are recorded every 125 ms for 8 hours on 25 March 2011, starting at 8:26:27. 
 

 
Figure 2-6 

2.3.5 
 

ame configuration several times running, or on several devices, it may 
be usef

 

ackup of the configuration currently displayed: 
iously opened, click on the Save button. A new 

ype a file name, then define a folder and its 
cation in the tree; click on Save to complete the backup. 

n: 
not open, select Configuration in the Device menu; after clicking 

 a file name or select one from among the files already 
ey were originally recorded; click on Load (open) to 

restore the configuration window with all of the previously recorded parameters. 

 

Reading a configuration: 
The Read button of the configuration window can be used to read back the configuration of 
the connected instrument (with an update of all fields). 

 

Backup and restoration of configuration 

To save time or reproduce the s
ul to save one or more configurations in your computer. 

B
In the bottom of the configuration window prev

ow, "Save as," prompts you to select or twind
lo

 

Restoring a configuratio
If the configuration window is 
on "Load", you are prompted to type
recorded, from the directory where th



 16

2.4  Display of the current status information of the instrument 
connected 
 
This information window is part of the instrument panel screen. It can be reduced in the bottom bar of 
the screen, restored to its original size, or closed by acting on the buttons at top right. 

 

Connection: indicates whether or not a link is established between the instrument and the PC 
(connected or disconnected) 

Identification (of the instrument): 

Model: number identifying the model; 

Serial number: serial number of the device; 

Firmware version: version number of the embedded software; 

 

Memory: 
Capacity: total quantity of usable memory in the instrument (in bytes); 

Used: quantity of memory already used (in bytes); 

 

Recording: 
Status: recording in progress or inactive; 

Campaign of measurements: number of recording sessions already performed in the device:; 

Remaining: time remaining to the next session (if there is one); 

Recording interval: time separating two data records; 

Mode: data recording management mode (Start/Stop, FIFO, XRM™, or Alarm); 

 

Configuration of the channels: 
CH1 to CH4: configuration information for each of the inputs 

 

Configuration of the alarms: 
CH1 and CH2: alarm configuration information (activated or deactivated) 

 

Battery: 
Battery voltage: indicates the battery voltage; 

 

Current status: 
inputs overloaded or not; 

inputs in alarm status or not; 

Time: current time in the instrument; 

Date: current date in the instrument; 
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Figure 2-7 

2.5  Backup and restoration of the presentations 
 
Restoring an optimal vision of all windows can be long and tedious. Selecting the Arrange the windows 
icon in the toolbar restores the optimal sizes and po ions of all windows. 

 

he sizes and positions of the windows can be modified. To move a window, click and hold in the title 
size a window, click and hold in its corner and move diagonally 

to reach

Once th
same a

 

 

sit

T
bar, drag to the desired location. To re

 the desired size. 

ese arrangements have been made, it may be useful to save them so as to reproduce the 
ppearance several times running or on several devices. 
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aving the presentation: 

in the File menu, select the "Save the presentation" option; a new "Save as" window prompts 
you to select or type a file name, then define a folder and its location in the tree; click on Save 
to terminate the backup. 

 

Importing a presentation: 
in the File menu, select the "Import a presentation" option; a new "Open" window prompts you 
to type a file name or select one from among the files already recorded. 

 

2.6 Displaying the various graphs 
 

The following different display windows can be opened or closed from the Display  menu. 

Waveform: 
This window (figure 2-8) is used to display the waveform of one period of the input signal. 

The trace is refreshed as the acquisitions continue. 

 

S

 
 

Figure 2-8 
 
Harmonic (depends on the model): 

This window (figure 2-9) is used to armonic spectrum of the input signal. The 
harmonics can be displayed in the form of a bargraph (or histogram) by selecting "Bar" at top 

display the h

right in the window, or else in text mode, in the form of a list, by selecting "Text". Another 
selection makes it possible to express the measurements as RMS values, peak values, or 
percentages of the fundamental. 



 19

The spectrum is refreshed as the acquisitions continue. 
 

 
 

Figure 2-9 
Trend: 

This window (figure 2-10) is used to display slow variations (the evolution of the quantity of the 
signal) over a certain duration. The trend curve represents the succession of acquisitions over 
a period of time. 

The trace is refreshed as the acquisitions continue. 
 

 
 

he display at 
displays the cor
or Caps key duri

Figure 2-10 
 
T the top of the window includes the various channels recorded; clicking on a channel 

responding trace; several channels can be selected simultaneously using the Control 
ng the selection process. 
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The real-time d
refreshed until t

The harmonics 
the ++, +, 0, –, a

 

2.7 
 
T
to the
them; ata are recorded directly in the computer as they are acquired. These data are not 

ecessarily also stored in the instrument, but it can be configured so save them also, in which case 
there will be two records, one in the computer and one in the instrument. 

In addition, traces of waveforms can be recorded (depending on the model) in the instrument by 
means of the screen of the instrument panel (this additional function is available only if the instrument 
is not already acquiring or recording a waveform). 

 

Starting the recording of the values in real time: 
1.  In the File menu, select "Start recording the values in real time"; a new window opens and 

prompts you to select or type a name for the database, then define its location in the tree; click 
on Save to create the database or Cancel to return to the instrument panel. 

2.  The creation of the database is accompanied by a window requesting information (figure 2-11) 
concerning the session (Operator, Site, Customize). This information remains linked to the 
session and will be used for the automatic writing of reports. 

 

isplay of the various traces can be frozen by checking the "Hold" box. No traces are 
he box is unchecked. 

and trend graphs can be zoomed in or out and restored to their original format using 
nd – – buttons. 

Backup of the measurements in real time 

he real-time data transmitted by the instrument can be recorded directly in a database corresponding 
 session. This differs from the process of downloading data stored in the instrument, then saving 
 here, the d

n

 
Figure 2-11 

 
– the Operator and Site pages are used to create lists of operators and sites, in order 
to save time in the preparation of reports. The Site page includes a reserved zone for 
the addition of remarks or complementary information. 
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– the Customize page has a list of defined usage parameters. Each parameter is 
 in the database. 
s that should be 

ssion, you are automatically asked 

background and its place is 
taken by a new window to help in defining new traces from predefined templates (see figure 2-
12 below); 

associated with a check box; the parameters checked will be kept
The Customize page can be used to define any other parameter
retrieved for the writing of reports. 

3.   After entering the various fields, click on "OK"; 

4.  All measurement data will be recorded until the "Stop recording in real time" command is 
activated in the File menu. When you stop a recording se
whether you want to open the database. 

5.  If you answer "YES", the main window of DataView® is moved to the 

 

 
Figure 2-12 

 

®

7.  To save this report, click on Save in the File menu and save the file to the directory of your 
choice. 

 

  

This window is used to define the type of curve it is desired to produce with the data just acquired. A 
type of trace is proposed, but it is possible to choose another. 
 

6. After choosing the type of trace, click on "OK". In the main window of DataView , a report 
including the desired graph is then displayed. 
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2.8 Downloading data recorded by the Simple Logger® II 
 

The batteries must be in good condition or be replaced so that the recorded data can be downloaded. 

The various measurement data recorded by the logger are transferred to the database in the computer 
using the "Download" command (this transfer can be effectuated only if at least one record has been 
made with at least the data corresponding to one measurement). 

The transfer of the data to the PC does not erase the data in the instrument. 

The transferred data will be saved only if they are recorded in a database. 
 

 

Downloading all data: 
1.  Select Download all data in the Device menu or click on the Download button in the toolbar. A 

new window informs you of the progress of the transfer; 

2.  Once the transfer is over, the "Save as" dialogue window is displayed; 

3.  Specify the name of the database in which the data will be recorded. If a database having this 
name already exists, you are asked if you want to replace the existing data in this base by the 
new data; if you answer YES, the old data will be overwritten; if you answer NO, you are 
prompted to propose another name for the database. 

4.  Once the name has been defined, enter the various information concerning the record, then click 
on OK; 

5.  When this backup is over, you are prompted to open the data base. If you answer YES, 
DataView® opens and proposes displaying a trace based on the data. A type of graph is 
proposed for the database; you can accept this choice or choose another type of trace. 

 

2.9  Report templates for the Simple Logger® II 
 

Additional information on the use of the templates is available in the help items of DataView®. 
 

Trend summary report: 
 

This report template is intended to be used with the Simple Logger® II; it can be used to generate a 
presentation comprising four working documents. 
 

These documents are: 

–a title page 

–a list of the trends or evolutions or results 

–a list of the alarms that occurred 

–the configuration of the instrument 

esired page at the 
ottom of the screen (just above the status bar). 

 

The firs ded session. 
Figure 2
 

 

ossible to navigate between these various pages by selecting the tab of the dIt is p
b

t document is the title page, which contains information concerning the recor
-13 below is an example this type of page. 
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Figure 2-13 
 
This page is used as the title page of the report and includes the following zones: 

 

–a text zone containing the text "Trend summary report"; 

–a summary zone containing the name of the database concerned by the report; 

–a summary zone containing informa  operator; 

–a summary zone containing information about the site concerned; 

OLE zone containing the CA logo; 

 

The pro cording to 
your ne operties option in the Element menu 

 

 

tion about the

–a summary zone containing the operator's remarks; 

–an 

perties associated with the windows can be used to customize each of the zones ac
eds. Select the zone to be modified, then choose the Pr
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The second document is used to display the curve of the evolution of the measurement results and
contains the following zones (see figure 2-14): 

 

–a list of chann

 

els containing a summary of the characteristics of the measurements; 

–a graphic zone reproducing the evolution of the measurement results in trace form; 

–a complete list of all results recorded; 

–a measurement zone indicating the measurement results for a specified instant on the graph; 

 
 

Figure 2-14 
 
The third document is used to display any alarms recorded; it includes the following three zones: (see 
figure 2-15) 

 

–a list of channels in which to select the channel of which the alarms are displayed; 

–a list of the alarms recorded in the selected channel; 

–a graphic zone reproducing, in trace form, the evolution of the measurement results over the 
duration of the selected alarm in the selected channel. 
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The Alarms sheet (Figure 2-15) is used to select a channel in the list of channels. The Alarms List will 
then be updated with the alarms (if any) that occurred in the selected channel. It is then possible to 
select an alarm, and the graphic frame will be adjusted to display the samples measured for the 
duration of this alarm. 

 
 

Figure 2-15 
 
The fourth document reports the exact config  instrument during this recording session. uration of the
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Figure 2-16 
 
Graphic zone 
 
 
The channel graphic zone is used to produce graphic representations from a database. The database 

 assigned to the trend graphic zone when it is created. This can be done manually by placing a graph 
ere or automatically using a model. 

elect 
traces. within a few 
pixels) a

When a  to the zone identifiers are placed on it. If several traces are 
located  click again to select, one by one, each 
of the tr

list can be accompanied by a list of the points sampled in the selected trace. 

is
th

The graphic zone provides additional tools for viewing the database. They can be used to create 
close-ups or panoramic views. In addition, traces and waveforms can be selected using the selection 
tool. 

 

Normally, the selection tool is used to select zones to be modified. This tool can also be used to s
A trace is selected when the selection tool is placed on any part of the drawing (to 
nd the left mouse button is pressed. 

 trace is selected, marks identical
 too close together to be discriminated, you can simply
aces. 

 

The zones can be linked together in such a way that when a trace is selected, another zone provides 
complementary information about the selection. For example, when a trace is selected in a graph, the 
summary trend 
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The creation of links between different zones may cause complex interactions. Further information is 
vailable in the DataView® User guide, accessible from the Help menu of DataView®. 

–Summary trend list 

els selected for display and the display properties can be modified at any time using the 
roperties of the graphs window. This window is opened by right-clicking (or double left-clicking) on 

perations. These actions modify the starting and ending times of the trace displayed. By modifying 
g and ending times displayed, you can zoom in or out or pan left or right, on the starting or 

ending points. 

To change the span of display of the graphic zone, select the zone using the selection or zoom tool. 
Then use the zoom or panoramic command from the Zoom menu or the toolbar. By clicking and 
dragging 

ist of channels  

a

 

This template includes the following links between zones: 

–Summary of session 

–List of channels 

–Indicator of amplitude 

 

The chann
p
the desired graphic zone, then choosing "Properties" in the list. 

 

The span of display of the channels graphic zone can be modified using the zoom and panoramic 
o
the startin

the zoom tool onto the desired zone, you can select a zone in which you can zoom again. 

 
 
L
 
 
The "list of channels" zone is a zone assigned to the channels graphic zone. The "list of channels" 
zone reproduces, in list form, all channels concerning the record. Each line has the specified 
parameters of use of the channel. It is possible to modify the overall appearance and the parameters 
displayed by opening the "Properties" option. 

You can go from one input to another in the list. The "Starting panoramic" command displays the first 
input of the list, while the "Ending panoramic" command displays the last. The command "Move right" 
or "Move left" displays the next or the previous input of the list. As the elements of the list are browsed, 
the selection moves from one element to the other for the channel concerned. 

In addition to moving in the list this way using the toolbar, you can also select a specific input with the 
mouse. The selected input is then highlighted, indicating which input is currently selected. 

 
 
Summary of session 
 
 
The "summary of session" zone is assigned to the channels graphic zone. It contains information 
about the recorded session. Like the other zones, it can be customized by opening the "Properties" 
option or by double left-clicking or single right-clicking on the zone, then choosing "Properties". 
 

The Trends template includes a "summary of session" zone containing the following information: 

–Starting time and duration of the record with identification of the instrument; 

–Database with the name and location of the file containing the data; 

–Information about the operator; 

–Information about where the session was recorded; 

–Operator's remarks. 
 

The texts displayed in the "summary of session" zone are static for as long as the associated 
database remains unchanged. This zone does not have the interactivity of the channels and trends 
graphic zones. 
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M
 

easurement zone 

 
The "measurement" zone is assigned to the channels graphic zone and displays the value of the 
sample at a specific place in the graph. Clicking on the graphic trace creates a vertical black line for 
which the "measurement" zone provides the amplitude of the signal accompanied by its precise date 
and time. Clicking on other sectors of the trace moves the black line accordingly and the 
corresponding information is updated. 

 
 
Text zone 
 
 
This text zone is used to display a text at a given place on the page. This text is static and can be 
modified only intentionally. This text zone is located in the upper part of the sheet and contains the title 
of the report. The text, its font, and other characteristics can be modified using the "Properties" option. 

 
 

 For more information about the use of the "instrument panel" of the Simple Logger® II or of 
DataView®, use the help files in the software. 

 
 



 29

 



07 - 2012

Code 693886A02 - Ed. 1

http://www.chauvin-arnoux.com

190, rue Championnet - 75876 PARIS Cedex 18 - FRANCE
Tél. : +33 1 44 85 44 85 - Fax : +33 1 46 27 73 89 - info@chauvin-arnoux.fr

Export : Tél. : +33 1 44 85 44 38 - Fax : +33 1 46 27 95 59 - export@chauvin-arnoux.fr

DEUTSCHLAND - Chauvin Arnoux GmbH
Straßburger Str. 34 - 77694 Kehl / Rhein
Tel: (07851) 99 26-0 - Fax: (07851) 99 26-60

SCHWEIZ - Chauvin Arnoux AG
Moosacherstrasse 15 - 8804 AU / ZH 
Tel: 044 727 75 55 - Fax: 044 727 75 56

ESPAÑA - Chauvin Arnoux Ibérica S.A.
C/ Roger de Flor, 293 - 1a Planta - 08025 Barcelona
Tel: 902 20 22 26 - Fax: 934 59 14 43

UNITED KINGDOM - Chauvin Arnoux Ltd
Unit 1 Nelson Ct - Flagship Sq - Shaw Cross Business Pk
Dewsbury, West Yorkshire - WF12 7TH
Tel: 01924 460 494 - Fax: 01924 455 328

ITALIA - Amra SpA
Via Sant’Ambrogio, 23/25 - 20050 Macherio (MI)
Tel: 039 245 75 45 - Fax: 039 481 561

MIDDLE EAST - Chauvin Arnoux Middle East
P.O. BOX 60-154 - 1241 2020 JAL EL DIB (Beirut) - LEBANON
Tel: (01) 890 425 - Fax: (01) 890 424

ÖSTERREICH - Chauvin Arnoux Ges.m.b.H
Slamastrasse 29/2/4 - 1230 Wien
Tel: 01 61 61 9 61-0 - Fax: 01 61 61 9 61-61

CHINA - Shanghai Pu-Jiang - Enerdis Instruments Co. Ltd
3 F, 3 rd Building - N° 381 Xiang De Road - 200081 SHANGHAI
Tel: +86 21 65 21 51 96 - Fax: +86 21 65 21 61 07

SCANDINAVIA - CA Mätsystem AB
Box 4501 - SE 18304 TÄBY
Tel: +46 8 50 52 68 00 - Fax: +46 8 50 52 68 10

USA - Chauvin Arnoux Inc - d.b.a AEMC Instruments
200 Foxborough Blvd. - Foxborough - MA 02035
Tel: (508) 698-2115 - Fax: (508) 698-2118

http://www.chauvin-arnoux.com

	NFDVA0590-couv-AN-1
	NFDV_A0590-AN-1
	TABLE OF CONTENTS
	INSTALLING THE SOFTWARE
	1.1 Installing DataView®

	2. INSTRUMENT PANEL OF THE SIMPLE LOGGER® II
	2.1  Opening the instrument panel
	2.2  Description of the instrument panel
	2.3  Description of the various configuration possibilities of a Simple Logger® II
	2.3.1 Record tab
	2.3.2 Adjustments of the Scales
	2.3.3 Adjustment of the Alarms
	2.3.4 Recording configuration
	2.3.5 Backup and restoration of configuration

	2.4  Display of the current status information of the instrument connected
	2.5  Backup and restoration of the presentations
	2.6 Displaying the various graphs
	2.7 Backup of the measurements in real time
	2.8 Downloading data recorded by the Simple Logger® II
	2.9  Report templates for the Simple Logger® II


	NFDVA0590-fond-AN-1

